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1 Demo

Thank you very much for your interest in our program GOOSE Inspector. We ask for your kind understanding that
the demo version is subject to the following restrictions:

· After 3 minutes of online operation, the program automatically goes offline and terminates the recording.
To start a new recording, a restart of the program is required.

· Neither data nor settings can be saved or exported.
· When reading in a configuration file (SCD or ICD), approximately 60% of the IEDs and 60% of the remaining

GOOSE are suppressed by means of a random function. This means that only a limited number of IEDs and
GOOSE will be available for test purposes. The representation in the SCD Viewer and in the Siemens

Application Monitor (SAM) is restricted accordingly. About 80% of all GOOSE messages are processed as if
they were not included in the configuration file. In order to be able to load another configuration file, a restart of
the program is required.

Initial Test with Demo Data

If it is not possible for you to record data, you can perform an initial test using demo data. The demo.scd and
demo.log files are available in the program directory of GOOSE Inspector. Since the demo.scd file is subject to
the restrictions described above, it might be necessary to load the file several times in order to be able to view an

IED and GOOSE messages in the SCD Viewer or the Siemens Application Monitor (SAM). As a next step, you
can now load the demo.lg6 file.

2 Installation

2.1 Installation Overview

The program is executable under Windows XP Professional SP2/SP3 (32 bits). A release for Vista (32 bits) will
be included in one of the next versions. 

Administrator rights are required for the installation of the program. The operation of the program, however, is also
possible without administrator rights.

Installation

Start the setup. The setup file is located in the "Programme" folder on CD. The file name is SetupGOOSE
Inspectorvx.exe (x is the version number). 

Example: SetupGOOSE Inspectorv0820.exe = the installation routine for GOOSE Inspector Version 0.8.2.0.

Follow the instructions provided on screen. As soon as the setup routine has been completed, the GOOSE
Inspector is immediately ready for operation, i.e. without a restart of the operating system.

A dongle is required as proof of the license required for program operation.

Each time a new user starts the program for the first time with his own user ID, the program will create a user-
specific data directory "C:\Documents and Settings\<User>\ Application Data\GOOSE Inspector Data\". This
directory contains the user-specific Log and program configuration files (*.cfg). The directory can be modified by
the corresponding user via the following menu in the main program: “Settings | Net interface/ Log... | Data
Directory”.

Uninstallation

To uninstall the program, use the "Software" utility routine provided by Windows (Start | Control Panel | Software).
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2.2 System Requirements

Component Minimum Recommended

Operating system Windows XP, 32 Bit, SP2/3 Windows XP, 32 Bit, SP2/3
Processor Single CPU 1,3 GHz Duo CPU 1,6 GHz
RAM 500MB 2 GB
Graphic card SVGA WXGA
Network units Network interface (Ethernet LAN, TCP/IP)Network interface (Ethernet LAN, TCP/

IP)
Interfaces One USB interface for the dongle One USB interface for the dongle
Table 1: System requirements

2.3 Storage Structure of the CD

Folder Sub-Folder Contents

Programme Setup file
Doku

English English dokumentation
German German dokumentation

Table 2: Storage structure of the CD

3 Overview

3.1 Description of Functions

Basic Functionality

The GOOSE Inspector  monitor program allows you to listen to IEC 61850 substation automation protocol
packets via the network.

It is connected to the network via the network interface of your PC.

The IEC 61850 packets are decoded (except GSE and SV), checked, displayed, filtered if required, saved in the
Log.lg6 circular buffer file and printed if required.

Figure 1: Main Window with packet list and Detailed View

Furthermore, the program monitors the GOOSE transmission via the network and displays the current status in a
comprehensive overview table in the GOOSE Monitor.

The import of a configuration file (SCD/ICD) extends the volume of data displayed in the Detailed View
accordingly. In addition, various views of the data structure of the IEDs, GOOSE messages, inputs und reports
are available when loading a configuration file. 

Operators of Siemens systems will be able to benefit from a particularly well arranged representation in the 
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Siemens Application Monitor (hereinafter referred to as the “SAM”). To simplify operation, the SAM provides the
same type of representations as conventional configuration programs.  This view shows the current status of
applications and GOOSE via icons highlighted in traffic-light colors.

Figure 2: Siemens Application Monitor (SAM)

Furthermore, the SAM allows the export of a signal list which provides a clear overview of the source and target of
a connection. The user has the option of creating a signal list for the systematic checking and documentation of
signals step by step.

User-Specific Data Directory

Each time a new user starts the program for the first time with his own user ID, the program will create a user-
specific data directory "C:\Documents and Settings\<User>\ Application Data\GOOSE Inspector Data\". This
directory contains the user-specific Log and program configuration files (*.cfg). The directory can be modified by
the corresponding user via the following menu in the main program: “Settings | Net interface/ Log... | Data
Directory”.

When exiting the program, the parameter settings, the representation settings and the log.lg6 circular buffer file
are saved automatically. 

Properties of the Log.lg6 Circular Buffer File

The program checks the packets received for formal correctness. Erroneous or unknown packets are marked
accordingly. All packets received are marked with a time stamp and saved in the circular buffer file Log.lg6.

The maximum size of the Log file and the data directory can be specified via parameter settings (see Parameters
for network and Log file ). The program always uses the “Log.lg6” file for recording. 

You can also display, filter and scroll up and down the Log file during reception. The use of this option is
recommended mainly for the real-time analysis of GOOSE errors during a recording phase.

Observe the recommendations concerning the maximum size of the circular buffer file and do not run or operate
any other program on your PC during a recording session.
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Colors and Filters

You can define the display colors for the server and the client using the related menu options in the Font size,
Message color menu. For the output of the packets, you can apply the following filtering criteria:  

· Time
· Packet status
· Packet source
· Packet type
· IP address (MMS)
· Any text (e.g. logic device, logic node or reference)
· GOOSE Control Block Reference
· Packet number and packet length. 

By entering the designations of the logic device and logic node in plain text and selecting MMS at the same time,
you can e.g. specifically filter those reports which include relevant switching states and measured values.

The GOOSE Control Block Reference can also be set by means of a simple right click in the GOOSE Monitor
and the SAM. This facilitates the GOOSE analysis.

3.2 Getting Started

Dongle

Plug the dongle into the USB interface and start the program.

Language

Via the “Settings | Language” menu, you can select the English or German user interface. The default setting
depends on the current system language and is either German or English.

Network Connection

Although the program does not send any data packets, you should ensure that your computer cannot cause
address conflicts in the network. For safety reasons, contact the administrator with regard to the correct
procedure, e.g. automatic reference of the IP address or use of a specific IP enabled for you.

Figure 3: Schematic representation of the network structure

http://siemens-russia.com/
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If you plug the network connector of your PC into a normal port of a switch, you will mainly receive GOOSE
messages. MMS services or general data traffic will not be forwarded to your PC via a normal switch. This can
be useful if you want to focus on the reception and analysis of GOOSE messages.

In order to listen to all packets, plug the network connector of your PC into the service port (monitor or mirror
port) of a switch whose parameters have been specified accordingly. Make sure that the packets which you
want to listen to (i.e. TCP/IP and multi-cast GOOSE packets) are actually transmitted via the port.  You can
also interconnect a switch with a mirror port (or HUB or TAP) into a device connection. A conventional
unmanaged switch is not suitable because it only forwards the MMS packets to the target addresses. 

Before starting the recording, select the desired network card in the menu: "Settings | Network/Log... ". Next,
click on OK to save the parameter settings.

Loading the Configuration File and Starting the Recording

If you have a configuration file (SCD/ICD) for your system, you should already load it before the first recording
session. You can also perform a recording without loading a configuration file and have it analyzed afterwards
based on the configuration file.

Load a configuration file via the following menu: "File | Open Config file (scd/icd)..." and select "Reset error
counter for a new capture".

Next, select the “Online View” view (View menu).
Select “All packets” (View menu).
Afterwards, go online (Mode menu). The following selection window opens:

 Figure 4: Selection options available at the start of a recording

Select "Reset counter and append capture to Log.lg6".

From now on, all received packets will be saved in the Log.lg6 circular buffer and shown without filtering.

Change the output format of the Detailed View using the View menu or the “3 to 6” hotkeys. The current output
format is shown in the title bar of the Main Window.

Additional display options before and after the recording are described in the Chapter “Program Windows and
Operation”.

Possible Error Messages of the Dongle

If “f.n.n.n dongle missing/incorrect” is displayed after selecting the online mode, perform the following checks:
- Were you logged on as an administrator upon the installation of the program?
- Is the dongle plugged into the USB interface?

The f.n.n.n error code has the following meaning:
2, 1011 oder 1034.n.n.n Dongle not found
1004, 1005 oder 1006.n.n.n Device driver not installed

http://siemens-russia.com/
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4 Program Windows and Operation

4.1 Main Window and Detailed View

The usual Windows conventions apply for maximizing, minimizing and closing the program windows.

The packets are shown in two windows, i.e. the Main Window and the Detailed View. In addition, the GOOSE
Monitor and the SAM can be used specifically for GOOSE monitoring. The SCD Viewer with its different views is
available for the detailed and structured representation of the configuration file.

Main Window

The Main Window includes the menu bar and shows each packet in a separate line. The following two views are
available:

· The "File View" for scrolling already saved packets
· The “Online View” for observing the currently arriving packets in real time

The "File View"

The “File View” allows the user to scroll the lg6 file, which has just opened, in order to perform specific analyses
of individual packets. This is also possible during a recording session, i.e. the user can scroll the data recorded in
the Log.lg6 circular buffer file. The data displayed in this view is influenced by the filter settings.  

Figure 5: The “File View” in the Main Window

Information about the current view is shown in the separate line below the menus. The packet data, the number of
the uppermost packet and the total number of packets are shown in the line below.
The following lines include the packet number, a time stamp, the time difference “d” to the packet displayed last,
the packet source address, the receiver address (i.e. the MAC or IP address with port) and the packet type.

The uppermost packet is shown in the Detailed View.
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In order to scroll in the current file, the scroll bar, the cursor keys, the mouse wheel and the hotkeys listed below
can be used while the Main Window is active.

Operation Effect

Mouse wheel or cursor keys 1 packet

Page Up/Down keys 5 packets

Page Up/Down keys + SHIFT 50 packets

Page Up/Down keys + Ctrl 500 packets

Page Up/Down keys + Ctrl +
SHIFT

5000 packets

End Packet received last/most recent packet

Home Packet received first/oldest packet
Table 3: Scrolling in the Main Window

A millisecond counter is used for the time stamp of the packets. Upon each change from Offline to Online mode,
this counter is synchronized with the PC clock time.

If the packets currently shown in the display are overwritten by the packets received online, the packet received
last will be displayed upon the next scrolling.

The “Online View”

The packets are shown one below the other in a consecutive list in the “Online View”. The packet received most
recently is shown in the bottom line of the list. The data displayed in this view is influenced by the filter settings.

Figure 6: The “Online View” in the Main Window

Information about the current view is shown in a separate line below the menus. 
The following lines have the same structure as in the “File View”.

The packet shown at the bottom of the list will be displayed at intervals of approx. one second in the Detailed
View. In case of events happening slowly, e.g. due to an appropriate filter selection for GOOSE or an
InformationReport, the values of the attributes can be traced in real time. 

In order to carefully view the packets received, press the F9 hotkey to open the “File View”. The display changes
and the program continues to receive packets in the background.
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Detailed View

The “current” packet is shown in the selected output format in the Detailed View. Select the output format via the
View menu or via hotkeys. The View menu can also be called up by clicking with the right mouse button in the
Main Window!

Using the ’TAB’ key, you can switch the focus between the Main Window and the Detailed View.

The "Logic" and "Details" views can be expanded by activating "SCD" in order to retrieve information from a
loaded configuration file.

      

Figure 7: "Logic" Detailed View without SCD                   Figure 8: "Details” Detailed View without SCD

      

Figure 9: "Logic" Detailed View with SCD                        Figure 10: "Details" Detailed View with SCD

When the Detailed View is active, the user can scroll the packets of the current file from this view. It is not
necessary to change to the Main Window. 

Operation Effect

Ctrl + cursor keys 1 packet

Ctrl + Page Up/Down keys 5 packets

Ctrl + End Packet received last/most recent packet

Ctrl + Home Packet received first/oldest packet
Table 4: Scrolling in the Main Window while Detailed View is active
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If the output of a packet is too large for the Detailed View, you can use the scroll bar, the mouse wheel or the
cursor keys in order to scroll up and down the Detailed View.

4.2 Hotkey operation

Although the graphic user interfaces of  GOOSE Inspector provide functions which can be operated with the
mouse, many functions can be executed faster and more conveniently using hotkeys. For this reason, this
chapter provides an overview of the most important hotkeys:

'F8' – Select the Online/Offline mode
Press ’F8’ to change between Online and Offline mode.

'F9’ – Select between 'File View' and 'Online View'
Press ’F9’ to change between 'File View’ and 'Online View’.

'F11' – Activate/deactivate the output filter
Press ’F11’ to activate or deactivate the output filter.

'F12' – Call up the output filter
Press ’F12’ to open the dialog for specifying the parameter settings of the output filter.

'1' – Show all packets
Press ‘1’ to show all packet types.

'2' – Show only 61850 packets
Press ‘2’ to show only 61850 (MMS and GOOSE) packets. The output filter provides an additional filtering
option.

'3' – Open the “Logic” Detailed View
The output in the Detailed View only displays the most important data.

'4' – Open the “Details” Detailed View
The output in the Detailed View shows more detailed information.

'6' – Byte-serial HEX display in the Detailed View
The output in the Detailed View is ‘hexadecimal’.

‘TAB’ key to switch between the Main Window and the Detailed View
Use the TAB key to switch the (input) focus between the Main Window and the Detailed View.

'Cursor Up/Down’ to scroll packet by packet (in the Main Window)
Use the cursor keys to scroll packet by packet (with the focus in the Main Window) or to scroll line by line (with
the focus in the Detailed View).

'Page Up/Down’ to scroll 5 packets up or down (in the Main Window)
Use the ‘Page Up/Down’ keys to scroll 5 packets up or down (with the focus in the Main Window) or to scroll by
ten lines (with the focus in the Detailed View).

'Ctrl+Page Up/Down’ to scroll 50 packets up or down (only in the Main Window)
Hold down the ‘Ctrl’ key and press 'Page Up/Down’ to scroll 50 packets up or down.

'SHIFT+Page Up/Down’ to scroll 500 packets up or down (only in the Main Window)
Hold down the ‘SHIFT’ key and press 'Page Up/Down’ to scroll 500 packets up or down.

'Ctrl+SHIFT+Page Up/Down’ to scroll 5,000 packets up or down (only in the Main Window)
Hold down the ‘Ctrl’ and 'SHIFT’ keys and press 'Page Up/Down’ to scroll 5,000 packets up or down.
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'Ctrl+Cursor Up/Down’ to scroll packet by packet (only in the Detailed View)
Hold down the ‘Ctrl’ key and press 'Cursor Up/Down’ to scroll packet by packet.

'Ctrl+Page Up/Down’ to scroll 5 packets up or down (only in the Detailed View)
Hold down the ‘Ctrl’ key and press 'Page Up/Down’ to scroll 5 packets up or down.

'Ctrl+D' to delete the current Log file
The ’Ctrl+D’ key combination deletes the current Log file and the GOOSE references. 

4.3 Siemens Application Monitor (SAM)

Operators of Siemens systems will be able to benefit from a particularly well arranged representation in the 
Siemens Application Monitor (hereinafter referred to as the “SAM”). To simplify operation, the SAM provides the
same type of representations as conventional configuration programs.  This view shows the current status of
applications and GOOSE via icons highlighted in traffic-light colors. 

The complete tree view, the Description area and the Parameters area in the SAM are only available after loading
an SCD with special features.

Structure of the SAM Window

The SAM window is divided into the following four areas:

· The tree view provides a graphical representation of all applications and the GOOSE messages included.
· The Description area in the upper center of the screen shows all sources and targets of the node selected

from the tree.
· The GOOSE Monitor in the bottom center of the screen shows runtime information concerning all GOOSE of

the node selected from the tree.
· The Parameters area in the far right of the screen compares information from the configuration file and

received parameters of the node selected from the tree.

Figure 11: The four areas of the Siemens Application Monitor (SAM) 
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Several menu items are available above the SAM. The following menu items can be used to execute SAM
functions:

· Reset counter – Resets all counters for errors and warnings; the left-hand side of the icons become green.
· SAM – Allows the user to hide individual columns of the description area. The setting is not saved at the end of

the program.
· Export signal list – Exports an SCV file which includes all sources and targets according to the configuration

file.
· GOOSE Monitor – Allows the user to hide individual columns of the GOOSE Monitor. The setting is not saved

at the end of the program.

You can sort according to any column in the Description area and the GOOSE Monitor. Place the mouse pointer
over the title bar and click with the left mouse button. Clicking again reverses the sorting order. The order of
sorting is not displayed.

Icons and Colors in the Tree View

The following four icons are used in the tree view of the SAM:

Subnet

Application

GOOSE / GOOSE control

GOOSE without application / undefined GOOSE
Table 5: Icons in the tree view of the SAM

Subnet, application and GOOSE
The icons are arranged based on the information included in the configuration file. A subnet is the uppermost
level; a GOOSE is the lowest element in the hierarchy.

GOOSE without application
This node collects GOOSE messages which have not been assigned to any application in the configuration file.

Undefined GOOSE
This node displays all GOOSE messages which have been transmitted via the network, but which are not
described in the configuration file.

Depending on the status of the node or element, the icons are shown in the following colors:

Configuration file

Normal Warning Error

Log file
Normal

Warning

Error
Table 6: Color combinations of the icons in the tree view of the SAM

The color in the left-hand side of the icon shows runtime warnings and runtime errors represented in more detail in
the GOOSE Monitor or in the Parameters area.
The color in the right-hand side of the icon shows warnings and errors with regard to the loaded configuration file. 

The colors change according to the following rule:

No warning or error / everything OK

At least one warning, but no error pending

At least one error, but warnings may be pending as well
Table 7: Significance of the colors of the icons in the SAM

Since the icons in a level always display the worst state of the icons arranged below, the cause of an error
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displayed at the uppermost level can be conveniently traced back to a lower level.

Figure 12: The application always shows the worst property of the GOOSE included

Warnings and Errors Concerning the Log File – Left-Hand Side of the

Icons

Warnings and errors with regard to the Log file are created during a recording session and can have the following
two causes:

· The running GOOSE transmission is not free of gaps and inconsistencies.
· The parameters transmitted with a GOOSE differ from the values defined in the configuration file.

Warnings and errors concerning the GOOSE transmission are shown in detail in the GOOSE Monitor.
Warnings and errors concerning the parameters are shown in detail in the Parameters area.

The warnings and details shown in the Parameters area and the GOOSE Monitor directly influence the status of a
GOOSE and thus the color shown in the left-hand side of the GOOSE icon.

GOOSE Monitor (in the SAM)

The information shown in the GOOSE Monitor is continuously updated and influences the color in the left-hand

side of the icons.

Figure 13: Example of a GOOSE with two errors and a GOOSE with two warnings… 

Figure 14: … and the corresponding representation in the tree view  
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Colum Function

Missing Field filled in red => GOOSE currently missing

Reference Reference of the GOOSE Control Block

MAC Sender MAC address of the sender

TAL Time allowed to live

Total Total number of GOOSE

E Total number of errors

W Total number of warnings

Stat.No. Number of errors caused by the status number

Seq.No. Number of errors caused by the sequence number

D_TAL Number of errors caused by at least a double timeout of the
permissible Time allowed to live (TAL)

S_TAL Number of warnings caused by at least a simple timeout of the
permissible Time allowed to live (TAL)

SGM Number of single missing GOOSE (simple sequence number
violation)

Reboot Number of detected reboots
Table 8: Significance of the columns of the GOOSE Monitor in the SAM 

Parameters Area

The parameters in the Parameters area are only captured once per recording phase. Most of the values are
already determined with the first GOOSE. The errors and warnings shown in the Parameters area influence the 
color in the left-hand side of the icons..

Figure 15: Parameters window for a GOOSE

The parameters displayed in green are checked. They change their color in case of discrepancies between the
configuration file and the Log file. At the same time, the warning or error will be shown as the status in the tree
view.

The MAC address here is the virtual receiver address. The sender address is displayed in the GOOSE Monitor.

The VLAN parameters are only evaluated upon their reception.

The minimum and maximum transmission times are determined, but not evaluated.

All other parameters displayed in black are not encoded in the GOOSE and are shown only for information
purposes.
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Warnings and Errors Concerning the Configuration File – Right-Hand

Side of the Icons

Detailed information on warnings or errors concerning the configuration file is shown by means of an extended tool
tip. To show the tool tip, place the cursor on the icon of a GOOSE. The extended tool tip is shown only for
GOOSE which appear in yellow or red on the right-hand side!

Figure 16: Example for a warning concerning the configuration file 

Setting Filters for Further Analyses in the Detailed View

If runtime warnings or runtime errors are shown for a GOOSE and have to be further investigated, it is helpful to
search the existing record for erroneous packets first and then further examine the correct transmissions which
took place before. In the SAM, a filter can be conveniently set as follows:

· In the GOOSE Monitor: by marking the desired GOOSE and clicking with the right mouse button
· In the tree view: by marking the desired GOOSE and clicking with the right mouse button

The following view opens in both cases:

Figure 17: Marking a GOOSE and setting a filter by clicking with the right mouse button 

Filter (all)                  => Shows all GOOSE packets of the selected GOOSE ControlBlock reference.
Filter (only erroneous) => Shows only erroneous GOOSE packets of the selected GOOSE ControlBlock
reference.

The convenient handling of filters is also supported in the Main Window. For more detailed information, refer to the
Chapter Output filters.
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4.4 SCD Viewer

The SCD Viewer shows the contents of a configuration file in the following tree views:

· IED shows the data structure of the individual IEDs.
· GOOSE shows the data included in a GOOSE and the inputs fed by this GOOSE.
· Input shows all external references to the configuration file and the corresponding GOOSE which includes

this data.
· Report shows the data structure of the individual reports.
· SAM opens the Siemens Application Monitor described in a separate chapter.

In addition to the tree view, the parameters and properties of the selected node are displayed in the information
box on the right-hand side.

Figure 18: Tree view of the data structure of an IED with additional information concerning the number of GOOSE in the IED  

In the IED tree view, the number of GOOSE messages and inputs is shown under IED and LD.
The output shown in the IED tree view can be modified by means of the "IED View" menu item.
Modified settings are lost when closing the window.
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Figure 19: GOOSE (GOOSE ControlBlock reference) with data and inputs included which are using this GOOSE  

Figure 20: Input (external reference) and GOOSE (GOOSE ControlBlock reference) with the required data (attribute)

http://siemens-russia.com/


20 GOOSE Inspector

© 2009 Berthold Boeser Engineering Consultants

Figure 21: Report with the corresponding DataSet and the data included in the DataSet

Icons and Colors in the SCD Viewer

IED

Server

Accesspoint

Logical Device

Logical Node

Data Object

Data Attribute
Basic Data Attribute

Report Control
Trigger Options
Option Fields

Data Set

Functional Constraint Data Attributes (FCDA)

GOOSE Control

Input

GOOSE

Data Attribute Type

Data Object Type

Enumeration Type

Enumeration Value

Logical Node Type

Table 9: Icons and their significance in the IED, GOOSE, Input and Report tree views
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4.5 GOOSE Monitor

The GOOSE Monitor allows the user to check the quality of all GOOSE in a network in real time and to represent
it in a comprehensive overview table.

The GOOSE Monitor is also available without a configuration file. In this case, however, it can only monitor those
GOOSE messages which have been received at least once during a recording session.

During a recording, all GOOSE received are evaluated with regard to their StatusNumber, SequenceNumber and
Time allowed to live (TAL). In addition, the complete failure of a GOOSE is monitored.

When a configuration file is loaded, the program additionally checks whether all configured GOOSE actually exist
in the network. 

Display of the Current Status of a GOOSE

The user can sort according to any column in the GOOSE Monitor. Place the mouse pointer over the title bar and
click with the left mouse button. Clicking again reverses the sorting order. The order of sorting is not displayed.

Figure 22: GOOSE Monitor with GOOSE examples for the Warning, OK and Error statuses  

The status of a GOOSE is defined as follows:

No warning or errors  / everything OK

At least one warning, but no error pending

At least one error, but warnings may be pending as well
Table 11: Significance of the colors in the Status field of the GOOSE Monitor

The Missing column is defined as follows:

GOOSE currently received as expected

GOOSE missing since at least 2 x Time allowed to Live (Missing)
Table 12: Significance of the colors in the Missing field of the GOOSE Monitor

If a GOOSE is set to ‘Missing’ and received again afterwards, ‘Missing’ is undone. However, all warnings and
errors caused by the failure are still shown.
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Table Structure

Colum Function Available without
configuration file

Status Green = OK, yellow = warning, red = error yes

Missing Field filled in red => GOOSE currently missing Yes, for GOOSE already
captured

Reference Reference of the GOOSE Control Block yes

MAC Sender MAC address of the sender yes

TAL Current Time allowed to live yes

Total Total number of GOOSE yes

F Total number of errors yes

W Total number of warnings yes

Stat.Nr. Number of errors caused by the status number yes

Seq.Nr. Number of errors caused by the sequence number yes

D_TAL Number of errors caused by at least a double timeout of the
permissible Time allowed to live (TAL)

yes

S_TAL Number of warnings caused by at least a simple timeout of
the permissible Time allowed to live (TAL)

yes

SGM Single GOOSE Missing - Number of single missing GOOSE
(simple sequence number violation)

yes

Reboot Number of reboots detected (Stat.No. = Seq.No. = 1) yes

LOG  X = GOOSE included in the file yes

SCD  X = GOOSE included in the configuration file yes

GPE Number of GOOSE parameter errors (i.e. the GOOSE
parameters transmitted do not match the configuration file)

no

GPW Number of GOOSE parameter warnings (i.e. the GOOSE
parameters transmitted do not match the configuration file)

no

Table 13: Significance of the columns in the GOOSE Monitor

The evaluation of the LOG and SCD columns allows the following conclusions if the configuration file is loaded:

LOG SCD Mögliche Ursachen

X · Configuration file not complete
· GOOSE with incorrect GOOSE ControlBlock Reference transmitted

X · Not all devices connected
· One device defective
· Incorrect configuration file loaded

X X · The transmission and the configuration file match – everything OK
Table 14: Possible causes for different combinations of the LOG and SCD in the GOOSE Monitor

The GOOSE Monitor Menu

Save
Saves the current view of the GOOSE Monitor as a CSV file under any name. 

View
Allows the user to hide individual columns of the GOOSE Monitor. The setting is not saved at the end of the
program.

Output
Allows the user to select whether he wants to show all GOOSE or only GOOSE with errors.
Furthermore, all counters for warnings and errors and the current status can be reset via Reset counters.
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5 Menus

The GOOSE Inspector program is operated via menus. To call up the online help for all main menus and dialogs,
press the “F1” key (i.e. select the menu and press F1).

The menus and input boxes can be selected via the mouse or the keyboard. The key selection is performed via
the "Alt" key and an "access key". The “access key” is the underlined letter in the menu text (e.g. “D” in the File
menu) or in the designation of the input box. With some operating systems, the access key is only shown in the
menu text after selecting the menu (by pressing the Alt key).

For frequently used commands (online, offline, view), you can use the related hotkeys, see Hotkey operation.
Hotkeys are single keys or key combinations for the direct execution of a command. For example, “Ctrl+D”
deletes the packets in the Log file.

Be aware that the Alt key activates the menu selection (a menu is highlighted). When the menu selection is
activated, the keyboard shortcuts are not effective. Pressing the Alt key again deactivates the menu selection
again.

5.1 File Menu

Use the commands of the File menu in order to open, save and print files.

Command Description Hotkey

Log delete… Deletes all packets in the Log file and the GOOSE references of the
GOOSE monitoring. Resets all counters.

Ctrl + D

Open… Displays the “Open lg6 file” dialog for opening an lg6 file.

Save as… Displays the “Save lg6 file” dialog for saving a 1:1 copy of the current
file (e.g. the Log file). New packets, however, are always saved in the
Log.lg6 Log file.

Print / Export Displays the “Print lg6 file” dialog. For more detailed information,
refer to the next chapter.

Open config file (scd/icd)…Displays the “Open configuration file” dialog for opening a
configuration file such as an SCD or ICD file. Furthermore, it allows
the user to open xml files written in the same format as an SCD or
ICD file.

Close config file (scd/icd)…Closes the open configuration file.

Quit Saves the current program version; the current Log file switches to
Offline mode and quits the program.

Table 15: Functions available in the File menu 

Print / Export File

This dialog allows the user to set the parameters for the output of the currently open file (i.e. any lg6 file or the
Log.lg6 circular buffer file) on a printer, or for the export of an lg6 or text file. Be aware that the output filter and the
output format are effective in this context. This allows the user e.g. to save only GOOSE in a separate lg6 file.
The output includes all information in the Detailed View

Packet output
Select whether you want to output the data on a printer or in a text file or lg6 file.

Path and name of file
For the output as text or lg6 file, the complete path, the file name and the corresponding file extension (txt or lg6)
must be specified under "Path and name of file".
e.g. C:\data\test.txt or C:\data\log.lg6. To start the output, click on OK.
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Printer selection
The printer is selected in a separate window. Select "To printer" and then click on OK to confirm. The printer
selection window opens.

5.2 Mode Menu

Use this menu in order to switch the program online/offline.

Command Description Hotkey

Online The program saves listened packets in the current Log file. F8

Offline The program does not save any packets. F8
Table 16: Functions available in the Mode menu

5.3 View Menu

In the View menu, you can select the packet type, the output format and the packet source. The selected
output format is also used for printing the Log file. Output filter allows the user to filter the packets.

Commands Description Hotkey

All packets Outputs all packets. 1

Only 61850 Outputs only GOOSE or MMS packets. The display behaves as if an
output filter was set to MMS and GOOSE.

2

Logical The output in the Detailed View is restricted to the most important
terms and contents.

3

Detailed The output in the Detailed View shows more detailed information. In
case of an erroneous transmission, Detailed provides additional
information concerning the structure of the packets.

4

Reserved The output of the Detailed View corresponds to the logical output. 5

Byte-ser. Hex. The output of all bytes of a packet is ‘hexadecimal’. The order
corresponds to the order received.

6

SCD The output in the Detailed View includes information from the loaded
configuration file.

File View Displays the packets of the lg6 file which has just been opened. The
user can scroll via the cursor keys or scroll bars, see Hotkey
operation.

F9

Online View The packets received are displayed in consecutive order. F9

GOOSE Monitor Opens the GOOSE Monitor.

GOOSE to Log All GOOSE references, the number of errors and the total number of
GOOSE are added in the lg6 file which has just been opened.

SCD Viewer Opens the  SCD Viewer which provides a comprehensive view of a
loaded configuration file.

Siemens Application
Monitor

Opens the Siemens Application Monitor (SAM).

Table 17: Functions available in the View menu

5.4 Settings Menu

Use the menu for the selection of the language, size and color of the output, network card, and for the selection of
the Log file settings.

Commands Description

Language Displays the sub-menu for the language selection.
Font size, packet colors…Displays the  Font size, packet colors dialog for setting the parameters for the font

size and the output colors.
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Commands Description

Net interface/Log... This dialog serves for the selection of the network card to be used and for defining
the properties and the size of the circular buffer file. See also Parameters for network
and Log file.

Table 18: Functions available in the Settings menu

5.5 Filter Menu

Use the menu for filtering the packet output on screen and on the printer and for activating and deactivating the
output filter.

Commands Description Hotkey

Output filter… Displays the Output filters setting dialog for influencing the output of
the packets.

F12

Output filter ON/OFF Activates or deactivates the output filter if you have defined the output
filter. This function allows you to deactivate the filter function without
having to redefine the output filter settings.

F11

Table 19: Functions available in the Filter menu

5.6 Help Menu

Use the Help menu in order to call up the online help and show the program version.

Commands Description Hotkey

Help… Opens the online help. F1

About… Displays the program version.
Table 20: Functions available in the Help menu

6 Output filters

6.1 Output Filters

The output filter influences the output of packets on screen, via a printer and upon the file export.

The output filter does not influence the recording of packets.

Filtering during and after a recording session

The output filter filters:

1. During the recording: packets for the online view

This allows the user to monitor individual packets in the Main Window and the Detailed View in real time,
such as one single GOOSE, an information report or “only erroneous” packets as a quick error overview.

2. During the recording: packets already saved in the Log.lg6 circular buffer file
This allows the user e.g. to filter an already detected error of a GOOSE. In order to avoid the loss of data,
however, the recording should be stopped if important events have occurred. Also read the related
information in the Chapter Circular Buffer File.

3. After the recording: packets of the current lg6 file 

This allows the user to restrict the display of packets in the Main Window and the Detailed View to those
packets which are actually relevant. The filter is also effective for the printing and export of a text or lg6 file.
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Define output filter settings

Press the F12 hotkey to open the window for defining the output filter settings.

To activate or deactivate the output filter, press the F11 hotkey. The settings of the output filter will be
maintained even if it is deactivated.

The filter is active if you have selected at least one criterion and not deactivated the output filter. For more
detailed information, refer to the "Filter Menu".

An active output filter is indicated by a related note in the status bar and the “Filtered” note in the title bar of the
packet output. 

Figure 23: Window for defining the output filter settings

All selected criteria are linked with a logical "and" operation, i.e. all conditions must be met for the packet to be
output.

Packets from
If this checkbox is ticked, only those packets which were received after the specified time are displayed.

Packets until
If this checkbox is ticked, only those packets which were received before the specified time are displayed.

Packet status
This parameter defines only error-free or erroneous packets. This filter is not effective if you have marked both
fields at the same time or no field at all.

Packet source
This parameter defines whether packets are output from the server and/or client.

Packet type
This parameter defines the packet types to be displayed.
- MMS according to 61850
- GOOSE according to 61850
- Detects GSE and SV and displays them in hexadecimal format.
- PackX stands for all remaining packets.
If you select only MMS and GOOSE, this corresponds to the selection of the “Only 61850” view.
This filter is not effective if you have marked all fields or no field at all.
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IP address (MMS)
If you activate this parameter, only packets with this address will be displayed (source or target).

Text 1 or 2
Displays only those packets which include the text. Since the 61850 references are transmitted in plain text,
this option allows e.g. the output of only those packets which concern a logic device. To output only a specific
report, enter its Report ID.

GOOSE reference
All GOOSE ControlBlock references are saved when opening an lg6 file and listening. This option allows you to
restrict the output to one single GOOSE. For more detailed information, refer to the following Chapter "Special
Filter Functions for Quick GOOSE Analysis".

Packet number
The packets in the Log file are numbered (1-n). This filter allows you to select a range or just one or two
individual packet numbers.

Field 1 Field 2 Field 3 Field 4 Output

equal 500 of any Packet 500

equal 500 or 600 Packet 500 and 600

equal 500 to 600 Packets 500 to 600

unequal 500 or 600 All packetes except 500 and 600

unequal 500 to 600 All packetes except 500 to 600
Table 21: Examples for filtering according to packet number

Packet length
These boxes allow you to filter packets with a specific length. The input and processing logic is identical with
the packet number.

Save and Load buttons
These buttons allow you to save and load filter settings. The .flt file extension is used.

Reset button
Clicking this button deactivates all filter criteria. This button therefore allows the initiation of an individual filter
setting.

Special Filter Functions for Quick GOOSE Analysis

By clicking the right mouse button, special, context-related filter functions are available for the quick restriction
of GOOSE with a warning or error.

1. Select one GOOSE1 and then click with the right mouse button to activate "Filter (only erroneous)".
2. Switch to the Main Window and place the error message to be analyzed at the uppermost position.
3. Next, click with the right mouse button to activate “Filter (all)”.
4. Scroll up by one packet in order to view the packet received before the erroneous packet.

1The following options are available by clicking with the right mouse button in the GOOSE Monitor or in the
SAM (tree view or GOOSE Monitor window):

Filter (all)                  => Shows all GOOSE packets of the selected GOOSE ControlBlock reference.
Filter (only erroneous) => Shows only erroneous GOOSE packets of the selected GOOSE ControlBlock
reference.

By switching between "Filter (only erroneous)" and "Filter (all)" in the Main Window, you can analyze all error
messages of the corresponding GOOSE ControlBlock reference. “Output filter ON/OFF” allows the temporary
display of all packets in order to detect the larger context of a fault.

http://siemens-russia.com/


28 GOOSE Inspector

© 2009 Berthold Boeser Engineering Consultants

Figure 24: Context-related filtering in the Main Window

 

7 Defining Settings

7.1 Parameters for Network and Log file

In this dialog, you select the network card to be used and define the properties and size of the Log file.

Network card
Select the desired network card.

Max. size of Log file [MB]
100MB is the default setting. Define the size in million bytes. Observe the notes provided under Log file with
regard to the size and restrictions. The memory capacity indicated here must be available on the hard disk.

Data directory
In Online mode, the program always saves the new packets in the Log.lg6 circular buffer file stored in the
directory indicated here. In Offline mode, you can save a copy of Log.lg6 under a different name in any directory
(“File | Save Log as” menu) or load an existing lg6 file for analysis purposes (“File | Open Log”).

7.2 Font size, Packet color

This dialog serves for the definition of the font size and the colors of the packet output. An example of the
selected colors is provided in the left-hand field.
The parameters are saved in the “W61850.cfg” file.

Font size
Select the desired font size.

Blank line between Messages in %
You can enter values between 0 and 200 percent. Zero means no blank line; 200 means two blank lines. The
value only refers to the Main Window.
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Server
Select the text color and the background color for the server.

Client
Select the text color and the background color for the client.

GOOSE
Select the text color and the background color for the GOOSE.

Head lines
Select the text color and the background color for the head line. The Main Window is filled up by the background
color of the head line.

Error message
Select the text color and the background color for the error and program messages. 

8 Circular Buffer File

8.1 Circular Buffer File

Structure and Functions
The file ID is indicated at the top of the Log.lg6 circular buffer file. It is followed by the parameters and the log
data. The log data are organized in a circular buffer. When the buffer is full, the oldest packet is overwritten by the
most recent packet.

To prevent this, you can delete the old packets before a new recording (Ctrl+D), increase the maximum size of
the Log file (see Parameters for network and Log file ) or restrict the recording time.

Restriction 
Since the program allows the analysis and filtering of existing data also during a recording session, the size of
the Log file must be restricted. Based on practical experience, the Log file should not occupy more than half of
your RAM. Packets might get lost if the Log file is too large and the Log file is filtered during a recording. 

Saving the contents of the circular buffer file and preventing the loss of packets
In order to save the contents of the Log.lg6 file, use the options of the “File | Save Log as...” menu. To do this,
you can use any file name for the backup copy. 

Deleting the contents of the Log.lg6 file before the next recording (Ctrl+D) allows you to benefit from the maximum
recording time without the risk of packet loss.

9 Program and Error Messages

9.1 Program Messages

Program messages provide you with information about the program version, the start and end of a recording
session and the "Reset counters" event. If a GOOSE has not arrived within the specified time and includes the
status "Missing", this will also be documented in a related program message.
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9.2 Error Messages

Packets which cause warnings or errors have the same priority with regard to their representation in the Main
Window. They are marked with an error text and displayed with the color defined for erroneous packets. The error
output is aborted as soon as the first discrepancy has been detected e.g. in a GOOSE. However, all
discrepancies within a GOOSE are detected and statistically captured by the error counters.

Particularly deep coding errors cannot be mapped in the Main Window. These errors are only shown in the
Detailed View if the corresponding packet is actually fully decoded and compared with the structure data of the
configuration file.

Due to the restricted computing power, it is not possible to fully decode all packets and check them with regard
to all possible aspects during a recording session.

10 IEC 61850 Coding

10.1 IEC 61850 Coding

Coding of Data Packets According to 61850

The coding according to 61850 is defined e.g. in the following standards:

Standard Description

IEC 61850-7-1 Principles and modules of communication

IEC 61850-7-3 Abstract common data classes and attribute definition

IEC 61850-7-4 Definition of logical nodes, data objects and their logical addressing

IEC 61850-8-1 Mapping for communication within the entire station
Table 22: Most important standards of the IEC 61850 for decoding

The following packet types are decoded: MMS with BER Coding in case of transmission with TCP/IP and
GOOSE with BER Coding.
GSE and SV are not decoded.

10.2 MMS with BER Coding

IEC 61850-8-1 describes the mapping, i.e. the conversion of services and data with MMS (ISO 9506 -
Manufacturing Message Specification).

MMS services and data are described in ASN1.

The connection serves for the transmission of data in ASN1 coding which have to be interpreted according to
the formal rules of MMS and mapped to 61850.
For more detailed information, refer to IEC 61850 Coding.

10.3 GOOSE with BER Coding

For more detailed information, refer to IEC 61850 Coding.

A GOOSE is used for the spontaneous and simultaneous transmission of time-critical data to several receivers.
The GOOSE is transmitted with a multi-cast address directly to the Ethernet level. The assignment of a higher
priority ensures that GOOSE are transmitted faster by suitable network components than MMS packets.

In a GOOSE, the data is transmitted as MMS data types in ASN1 coding.
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Figure 25: Structure of a GOOSE

11 Terms and Abbreviations

Definition of Terms

lg6 file
Files in the lg6 data format are referred to as lg6 files.

Circular buffer file = Log.lg6 = Log file
The Log.lg6 circular buffer file is a special lg6 file. It is also referred to as Log file and exists only once.
The Log.lg6 file is the only file in which data is saved during a recording.
All functions described for lg6 files can also be applied to the Log.lg6 file.

The Log file becomes the lg6 file
If the entire contents of the Log.lg6 file, or only individual packets depending on the filter definition, are saved, this
file is assigned a file name and the .lg6 file extension. This file then has to be referred to as an lg6 file and no
longer as a Log file. 
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Abbreviations

Abbreviations in the GOOSE Monitor, the SAM and the SCD Viewer are described in the corresponding chapters.

$ Hexadecimal format
AppID Application Identifier
ASN.1 Abstract Syntax Notation 1
CB Reference GOOSE Control Block Reference
Client The packet was sent by the client.
d= Delta time in seconds = time of the current packet – time of the previous packet
DA Data Attribute
DO Data Object
FCDA Functional Constaint Data Attribute
GOOSE Generic Object Oriented Substation Event
ICD IED Configuration Description
IED Intelligent Electronic Device
LD Logical Device
lg6 file see Definition of Terms
LN Logical Node
Log file see Definition of Terms
Log.lg6 see Definition of Terms
LSU Leap Seconds Unknown
MMS Manufacturing Messaging Specification
Packet X No 61850 packet
PM Program message
SAM Siemens Application Monitor
SCD System Configuration Description
Server The packet was sent by the server
SGM Single Goose Missing. SGM is a warning and not an error.
VLAN Virtual LAN

 
IP/TCP packets

ACK Acknowledgment number valid bit
Ack= Acknowledgment number
ARP Address Resolution Protocol
DF Don’t Fragment
Fin End of data flag
ID Identification
IP Internet Protocol, Internet Protocol address
MAC Media Access Control Address
MF More Fragments
Offset Fragment offset
Packet Packet, frame
Prot Protocol Version
PSH Push control bit
RST Reset connection flag
Seq= Sequence number
SYN Synchronize sequence numbers flag
TCP Transmission Control Protocol
TLg Total Length = Length IP Header + data
TOS Type of Service
TTL Time to Live
Type= Packet type (hexadecimal)
UDP User Datagram Protocol
URG Urgent pointer valid flag
Window= Number of data bytes which the sender of this segment is willing to accept
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12 Known Properties and Restrictions

Known properties and restrictions do not give rise for any claim for warranty for defects.

Known properties and restrictions do not give rise to any claim for correction of defects.

1. One error text per packet in the Main Window and the Detailed View
One single error per packet is displayed in the Main Window and the Detailed View. If one single GOOSE
includes several errors, not all of them will be displayed, but only the error which has been detected first due to
the program structure.
However, all errors are counted by the counters of the GOOSE Monitor and the SAM. Therefore, even one single
erroneous GOOSE can cause several counted errors. 

2. Warnings are output in the same color as errors in the Main Window
There is no specific color for warnings in the Main Window.

Read the output text which includes a hint regarding the cause of the message.

3. An inappropriate configuration file is not indicated expressly
If an lg6 file and a configuration file do not match, this is currently neither indicated directly nor highlighted by a
special color. Only the GOOSE Monitor shows that GOOSE included in the configuration file are not included in
the Log file, or that the GOOSE included in the Log file are not included in the configuration file. Furthermore,
almost all GOOSE counters are set to 0, and there is a high number of undefined GOOSE.

4. No formal check of configuration files
The configuration files (SCD or ICD) are not checked based on formal criteria during the read-in process.

Check the configuration files by means of appropriate tools before reading them into the GOOSE Inspector.

5. Deviations in the encoded data section of GOOSE or MMS are not detected in real time
Since not all packets are completely decoded in real time, discrepancies in the encoded data section remain
undetected during a recording. Discrepancies are only shown during the specific output of packets in the Detailed
View.

6. Effect of the size restriction of the Log.lg6 file

The program runs slowly in case of an excessively large Log file

The Log.lg6 file is structured as a circular buffer, and the size can be defined. If the file becomes too large and the
operating system relocates parts of the file to the hard disk, mainly the output of filtered data becomes very slow.
The filtering in the "File View" in the Main Window during a recording can lead to a packet loss in this case. This
function therefore should not be used with large Log files. For the same reasons, we recommend not to run any
further programs on the same computer during a recording.

Based on practical experience, the Log file should not be larger than half as large as the physical RAM. 2GB is
the absolute upper limit. In case of a large network with 1,000 different GOOSE of a small size with an average
transmission interval of 1.5 seconds, this corresponds to a recording period of approximately 4 hours. 

Principal “data loss” in a Log file due to the circular buffer function

Due to the organizational structure as a buffer memory, old packets and program messages are principally
overwritten by new packets as soon as the configurable size of the Log file has been reached. In this case, only
the most recent packets and program messages are stored in the Log file upon completion of the recording. 
The counters for notes and errors in the GOOSE Monitor, however, are incremented during the entire recording
period. The views and counter readings in the SAM or GOOSE Monitor, immediately on termination of the
recording, therefore cannot be reached through loading the Log file a second time. 
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Delete the Log file before starting a new recording session and restrict the recording period in order to be able to
precisely trace individual events.

The counter readings in the GOOSE Monitor can documented through the export of a csv file. The views in the
SAM cannot be saved. Relevant information should therefore be documented by means of screenshots.

The number of a packet changes as soon as the circular buffer is full. 

When the circular buffer file is full and the recording persists, the numbering of the packets is changed
consecutively. The most recent packet always has the highest number, whereas the oldest packet of the circular
buffer file has the number 1. Since a new packet first has the highest number and then becomes older, it finally
has the number of the last packet (1) and is overwritten afterwards. The analysis (filtering) in a completely filled
circular buffer file, during a recording, therefore does not make sense.

The detailed error analysis is restricted in case of long-term recordings.

Due to the circular buffer structure and the restrictions with regard to the maximum file size, notes and errors in
case of long recordings cannot be traced back in detail. In the GOOSE Monitor and in the SAM, there is only a
message which informs the user that an error has occurred.

8. Long loading times of lg6 files and configuration files
The loading of large lg6 files and large, complex configuration files can take several minutes depending on the
processing power of the computer. During this time, the program cannot be used for other functions.

When using notebooks and laptops, it must urgently be ensured that the CPU can run at full speed. The power
management of notebooks and laptops can significantly reduce the CPU performance, which can result in a
multiplication of the loading time.  

9. Not all MMS are detected and decoded
Not all MMS are decoded at the present time. Individual types are not implemented.

10. GSE (GSSE) and SV (SMV) are not detected and decoded

11. Dynamically created Information Reports are represented at the MMS level
Dynamically created reports are not described in the configuration file and therefore are only represented at the
MMS level.

12. The settings of the GOOSE Monitor, SAM and SCD Viewer are not and cannot be saved
The settings with regard to the position, structure, sorting, etc. of the GOOSE Monitor, SAM und SCD Viewer are
not saved automatically and cannot be saved manually.

13. The representations in the SAM are not and cannot be saved
Document the most important events by means of screenshots. 

As long as no overflow of the circular buffer file has occurred during the recording, the representation can be fully
restored by loading an old Log file and the identical configuration file.

14. The GOOSE Monitor, SAM and SCD Viewer can be opened, but cannot be closed via the View
menu
The windows of the GOOSE Monitor, SAM and SCD Viewer must be closed manually. 

15. When starting the program, the Log.lg6 file, but not the last configuration file is loaded
automatically
Load the desired configuration file via the “File” menu.

16. The program always goes offline upon termination and always starts offline

17. For SCD errors in the tree view of the SAM, the tool tip for the display of the cause of a warning or
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error does not work while the Windows search function is active. 
Close the Windows search function in order to ensure that Windows shows the tool tip.

18. Loss of packtes due to the use of other programs during a recording
We recommend not to run any further programs on the same computer during a recording.
We also recommend not to run the monitor program itself on a host or substation host which is a active part of
the network.
In both cases you may lose packets.

13 End User License Agreement

Copyright (C) 2009 Berthold Boeser Engineering Consultants
End User License Agreement

By using this program, you accept this License Agreement and confirm that you have read and understood its
contents and agree with of its all terms and conditions. 

1) I herewith grant the purchaser of my program a non-exclusive right of use. The program may only be used with
the dongle purchased. The program may be installed on several computers, and a backup copy may be
performed. Any alterations to or transfer of the program are prohibited.

2) The program and the documentation were created with the utmost care. Any errors which prevent the use of
the program for the intended purpose shall be rectified within a period of 12 months.

3) Known properties and restrictions do not give rise for any claim for warranty for defects and do not give rise to
any claim for correction of defects.

4) The purchaser uses the program at his own risk. Except cases of gross negligence or deliberate actions, I do
not assume any liability for:
- losses or loss of profit through the use of the program
- loss or damage of data
- consequential loss or business interruption
- personal injury of any kind

5) Any claims for damages, independent of their legal basis, are restricted to the level of the license fee paid. Any
liability for claims shall cease 12 months after delivery.

6) This Agreement shall be subject to German law. Place of jurisdiction for disputes which arise from or in
connection with this Agreement shall be my main place of business. If individual provisions of this License
Agreement are or become invalid, this shall not affect the validity of the remainder. Invalid provisions shall be

replaced by such provisions which are valid and come closest to the intended purpose of the original.
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